Virtual Infrastructure Web Access
Administrator’s Guide

Update 2 and later for
ESX Server 3.5 and VirtualCenter 2.5
Virtual Infrastructure Web Access Administrator’s Guide
Revision: 20090612
Item: EN-000030-02

You can find the most up-to-date technical documentation on our Web site at: http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to: docfeedback@vmware.com

© 2006–2009 VMware, Inc. All rights reserved. This product is protected by U.S. and international copyright and intellectual property laws. VMware products are covered by one or more patents listed at http://www.vmware.com/go/patents.
VMware, the VMware “boxes” logo and design, Virtual SMP and VMotion are registered trademarks or trademarks of VMware, Inc. in the United States and/or other jurisdictions. All other marks and names mentioned herein may be trademarks of their respective companies.
4 Using Virtual Infrastructure Web Access to Manage Virtual Machines 27
   Summary, Events, Alarms, Tasks, and Console Views 27
   Viewing Summary Information About Virtual Machines 28
   Viewing Virtual Machine Events 29
   Viewing Virtual Machine Alarms 30
   Viewing Virtual Machine Tasks 30
   Using the Console 31
      Entering Full Screen Mode 33
   Installing VMware Tools in the Guest Operating System 33
   Changing the Power State of a Virtual Machine 34
   Creating and Sharing Remote Console URLs 35

5 Editing an Existing Virtual Machine’s Configuration 37
   Editing the Configuration of Existing Virtual Machines 37
   Understanding Permissions and Virtual Machines 37
   Using Client Devices 38
   Editing the Hardware Configuration of a Virtual Machine 38
      Editing Processors 38
      Editing Memory Configuration 39
      Editing or Removing a CD/DVD Drive 39
      Editing or Removing a Disk Drive 40
      Editing or Removing a Hard Disk 42
      Editing or Removing a SCSI Device 45
      Editing a SCSI Controller 45
      Editing or Removing a Network Adapter 46
      Editing or Removing a Parallel Port 48
      Editing or Removing a Serial Port 48
   Adding Hardware to a Virtual Machine 50
      Adding a Hard Disk 50
      Adding a Network Adapter 56
      Adding a CD/DVD Drive 56
      Adding a Disk Drive 57
      Adding a Serial Port 58
      Adding a Parallel Port 61
      Adding a SCSI Device 62
Contents

Changing Virtual Machine Options  62
Changing General Settings  62
Changing Power State Options  63
Changing Advanced Settings  64

Index  65
About This Book

This manual, the Virtual Infrastructure Web Access Administrator’s Guide, provides information on how to configure virtual machines for ESX Server and VirtualCenter Server.

The Virtual Infrastructure Web Access Administrator’s Guide discusses ESX Server 3.5.
To read about ESX Server 3i version 3.5, see http://www.vmware.com/support/pubs/vi_pubs.html.

For ease of discussion, this book uses the following product naming conventions:

- For topics specific to ESX Server 3.5, this book uses the term “ESX Server 3.”
- For topics specific to ESX Server 3i version 3.5, this book uses the term “ESX Server 3i.”
- For topics common to both products, this book uses the term “ESX Server.”
- When the identification of a specific release is important to a discussion, this book refers to the product by its full, versioned name.
- When a discussion applies to all versions of ESX Server for VMware® Infrastructure 3, this book uses the term “ESX Server 3.x.”

Intended Audience

The information presented in this manual is written for experienced system administrators who are familiar with Windows or Linux virtual machine technology and datacenter operations.
Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to:

docfeedback@vmware.com

VMware Infrastructure Documentation

The VMware Infrastructure documentation consists of the combined VMware VirtualCenter and ESX Server documentation set.

Abbreviations Used in Figures

The figures in this book use the abbreviations listed in Table 1.

Table 1. Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>database</td>
<td>VirtualCenter database</td>
</tr>
<tr>
<td>datastore</td>
<td>Storage for the managed host</td>
</tr>
<tr>
<td>dsk#</td>
<td>Storage disk for the managed host</td>
</tr>
<tr>
<td>hosts</td>
<td>VirtualCenter managed hosts</td>
</tr>
<tr>
<td>SAN</td>
<td>Storage area network type datastore shared between managed hosts</td>
</tr>
<tr>
<td>tplt</td>
<td>Template</td>
</tr>
<tr>
<td>user#</td>
<td>User with access permissions</td>
</tr>
<tr>
<td>VC</td>
<td>VirtualCenter</td>
</tr>
<tr>
<td>VM#</td>
<td>Virtual machines on a managed host</td>
</tr>
</tbody>
</table>
Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current versions of this book and other books, go to:


Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to:

http://www.vmware.com/support

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to:

http://www.vmware.com/support/phone_support.html

Support Offerings

Find out how VMware support offerings can help meet your business needs. Go to:

http://www.vmware.com/support/services

VMware Education Services

VMware courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. For more information about VMware Education Services, go to:

http://mylearn1.vmware.com/mgrreg/index.cfm
Introducing VMware Virtual Infrastructure Web Access

This chapter introduces Virtual Infrastructure (VI) Web Access components and operations. This chapter contains the following topics:

- “What Is Virtual Infrastructure Web Access?” on page 11
- “Key Features” on page 12

What Is Virtual Infrastructure Web Access?

VI Web Access is a browser-based application designed to manage virtual machines on ESX Server and VirtualCenter deployments. This version of VI Web Access focuses on the following aspects of virtual machine management:

- System administrators who need to access virtual machines without a VI Client
- People who use virtual machines as remote desktops
- Virtual Infrastructure administrators who need to interact with virtual machines remotely

The VI Web Access interface provides an overview of all of the virtual machines on an ESX Server system and VirtualCenter Server. Using VI Web Access to manage virtual machines, you can:

- Use a browser to view hosts and the virtual machine details
- Perform power operations on virtual machines
- Edit a virtual machine’s configuration and hardware
- Generate Remote Console URLs that users can use to access their virtual machines
Virtual Infrastructure Web Access Administrator’s Guide

- Interact with the guest operating systems running on the virtual machines
- Access ESX Server hosts and VirtualCenter Servers from Linux systems

VI Web Access focuses on virtual machine management and does not offer the full range of administrative tasks available through the VI Client.

**Key Features**

This section describes key features of VI Web Access.

**Virtual Machine Management**

Users can access virtual machine status information and power controls by connecting directly to an ESX Server host or a VirtualCenter Server.

Users can interact with virtual machines by using the keyboard and mouse in window or full screen mode from any compatible web browser.

**Remote Console URLs**

Users can share virtual machines with customized controls and environments using standard Web browser URLs.

Each URL provides direct access to a specific virtual machine from supported Web browsers.

**Usability**

Administrators can provide end users with access to virtual machines.

Users can access virtual machines on ESX Server hosts and VirtualCenter Servers without installing the Virtual Infrastructure client.

Users and Administrators can use VI Web Access to access ESX Server hosts and VirtualCenter Servers from both Linux and Windows systems.

Client devices allow you to use disk and CD/DVD drives from your own computers to install software or copy data.

**Simplified Remote Console Use**

You can complete your work without distractions by customizing remote console URLs that present only as many user interface controls as necessary.
This chapter introduces VI Web Access components and operations. This chapter contains the following topics:

- “System and Browser Requirements” on page 13
- “Installing Virtual Infrastructure Web Access” on page 14
- “Running and Configuring Virtual Infrastructure Web Access Service” on page 15
- “Setting Virtual Infrastructure Web Access Passwords” on page 15
- “Installing the VMware Virtual Infrastructure Web Access Plug-In” on page 15

System and Browser Requirements

This section outlines the system and browser requirements for using VI Web Access.

System Requirements

To use VI Web Access, your system must meet the following requirements

Hardware

- Standard x86-based computer
- 266MHz processor minimum (500MHz or faster recommended)
- 128MB RAM minimum (256MB or more recommended)
- 20MB (for Windows hosts) or 10MB (for Linux hosts) free disk space to install the VMware Virtual Infrastructure plug-in
Operating Systems

VI Web Access is compatible with the following operating systems.

Windows

- Windows XP Professional Service Pack 2 or Windows XP Home Edition Service Pack 2

Linux

- Linux kernel 2.2.14 or later
- glibc 2.3.2 or later
- XFree86-3.3.6 or later
- gtk+2.0 or later
- fontconfig (also known as xft)
- libstdc++5 or later

Browser Requirements

(See Update) To access VMware Virtual Infrastructure Web Access, you should have one of the following browsers installed:

- Internet Explorer 6.0
- Mozilla Firefox 1.5 or higher for Microsoft Windows
- Mozilla Firefox 1.5 or higher for Linux

NOTE Other browsers are not actively excluded, but VMware has certified VI Web Access with only the browsers listed above. See your browser vendor's own documentation for additional requirements. For the best experience, make sure your browser includes all of the security and stability updates recommended by its vendor.

Installing Virtual Infrastructure Web Access

VI Web Access is installed when ESX Server is installed. On VirtualCenter Server, you can install VI Web Access from the VirtualCenter Server Windows setup package.
Running and Configuring Virtual Infrastructure Web Access Service

To connect to an ESX Server host or VirtualCenter Server with VI Web Access, the VI Web Access service must be running on the host or server. VI Web Access connections are available by default with ESX Server and VirtualCenter Server.

Setting Virtual Infrastructure Web Access Passwords

Administrators must have a valid user name and password to use VI Web Access to access ESX Server hosts and VirtualCenter Servers. The password defaults are as follows:

- **ESX Server** – The default user is root. The root password is configured when you install ESX Server.
- **VirtualCenter Server** – The default user is Administrator. The Administrator password is configured during the installation of VirtualCenter Server. Administrators can add users and groups to allow users access to VI Web Access.

For more information about setting passwords during installation, see the *ESX Server 3 Installation Guide*.

Installing the VMware Virtual Infrastructure Web Access Plug-In

To run VI Web Access, install the VMware Virtual Infrastructure plug-in.

**To install VMware Virtual Infrastructure ActiveX Control in Microsoft Internet Explorer**

1. In the Internet Explorer window, type the VI Web Access URL:
   
   `<https://vmwarehost.yourdomain.com/ui>`

2. Log in to VI Web Access using the user name and password for the host to which you are connecting.

3. Select a virtual machine from the Virtual Machines list.

4. Click the **Console** tab.

5. If prompted, click **Install**.

   You might need to refresh your browser after installation.
To install the VMware Virtual Infrastructure plug-in in Mozilla Firefox for Linux and Windows

1 In the Firefox window, type the VI Web Access URL:
   https://vmwarehost.yourdomain.com/ui
2 Log in to VI Web Access using the user name and password for the host to which you are connecting.
3 Select a virtual machine from the Virtual Machines list.
4 Click the Console tab and click Install Plugin.
5 Select Edit Options and click Allow.
6 Click Close and click Install Plugin.
7 Click Install Now.
8 After the installation is complete, choose View > Reload to reload the page.

Troubleshooting

The following section guides you through common VI Web Access troubleshooting scenarios.

Troubleshooting Your VI Web Access Connection

If you cannot to connect to the ESX Server host by using VI Web Access, you might need to restart the VI Web Access service on your host.

To troubleshoot VI Web Access service on an ESX Server host

1 Log directly into your ESX Server service console.
2 Enter service vmware-webAccess status to check the status of the host's VI Web Access service.
3 If VI Web Access service is stopped, enter service vmware-webAccess start.
   If the Console does not load properly, you might need to troubleshoot the plug-in installation.

To check the plug-in version in Mozilla Firefox

1 Go to about:plugins in the browser.
   VMware WebCenter Remote MKS Plug-in should show version 2.0.1.0.
2 If any other version number appears, reinstall the plug-in.
To check the plug-in version in Microsoft Internet Explorer

1. Go to Tools > Internet Options.
2. Click Settings.
3. Click View Objects.
   The Version column for QuickMksAxCtl should show 2.0.1.0.
4. If any other version number appears, right click QuickMksAxCtl and select Remove.
5. Re-install the plug-in.

To troubleshoot the plug-in installation in Mozilla Firefox

1. Quit Firefox (choose File > Quit).
2. Restart Firefox.
3. Type the VI Web Access URL:
   https://vmwarehost.yourdomain.com/ui
4. Select a virtual machine from the Virtual Machines list.
5. Click the Console tab.
6. When you are prompted to install the plug-in, click OK.
7. After the installation is complete, choose View > Reload to reload the page.

To troubleshoot the plug-in installation in Microsoft Internet Explorer

1. Quit Internet Explorer (choose File > Close).
2. Launch Internet Explorer again.
3. In the Internet Explorer window, type the VI Web Access URL:
   https://vmwarehost.yourdomain.com/ui
4. Select a virtual machine from the Virtual Machines list.
5. Click the Console tab.
6. When you are prompted to install the plug-in, click OK.
7. After the installation is complete, choose View > Refresh to reload the page.
Troubleshooting Virtual Machine Power Operations

There are several reasons why you might be unable to power on a virtual machine.

- You are missing the required libraries.
  
  To correct this problem, use a dependency checker such as ldd against libmks.so, viewer, and remotemks binaries. Use the following commands to determine the missing libraries:

  a. cd into ~/.mozilla/plugins
  b. ldd ./libmks.so | grep not
  c. ldd ./viewer | grep not
  d. ldd ./remotemks | grep not

  The output from steps b, c, and d indicate missing libraries. If these steps produce no output, all required libraries are available.

- You have a non-GTK Mozilla browser.
  
  To correct this problem, use a GTK-based Mozilla browser, available at www.mozilla.org.

- You have a version of Firefox that was included with your Linux distribution. Some distributions package Firefox incorrectly and the resulting package does not work with VI Web Access.

  To correct this problem, get the latest version of Firefox from www.mozilla.org.
Getting Started with Virtual Infrastructure Web Access

This chapter guides you through the basic tasks you must complete to begin using VI Web Access.

This chapter includes the following topics:

- “Connecting to Virtual Infrastructure Web Access” on page 19
- “Logging Out” on page 20
- “Overview of the Virtual Infrastructure Web Access Default View” on page 20

Connecting to Virtual Infrastructure Web Access

After VI Web Access authorizes your user name and password, the VI Web Access home page appears. The VI Web Access home page contains:

- High-level details about all the virtual machines on the server to which you are connected
- Access to the details page for a virtual machine where you find information about virtual devices, configuration options, and a summary of recent Events
To log in to VI Web Access

1. Start your Web browser.

2. Enter the URL of your ESX Server or your VirtualCenter Server installation:
   
   `https://<host or server name>/ui`
   
   The login page contains fields for your user name and password.

3. Enter your user name and password and click Log In.
   
   The VI Web Access home page appears. For information about the Status Monitor page, see “Overview of the Virtual Infrastructure Web Access Default View” on page 20.

   To log out of VI Web Access, see “Logging Out” on page 20.

   **NOTE** If you have a pop-up blocker enabled, a message appears that says a pop-up blocker has been detected. Disable your pop-up blocker to use client devices.

Logging Out

You can log out of VI Web Access by clicking the Log Out link found at the upper-right corner of every page. If you have active client device connections, you are prompted to confirm that you want to log out.

Logging out disconnects client devices that any of the virtual machines are using.

Overview of the Virtual Infrastructure Web Access Default View

The VI Web Access default view contains a high-level view of the ESX Server or VirtualCenter Server that you are logged in to, including a list of all registered virtual machines and their status.
The VMware VI Web Access window is divided into four main sections:

- **Inventory panel** – Appearing on the left, this area displays a list of virtual machines (ESX Server) or the virtual machine hierarchical inventory (VirtualCenter Server). Click a virtual machine to display information about the virtual machine and available options for the virtual machine.

- **Workspace** – Appearing on the right, this is the main part of the window. When the host (ESX Server) or a datacenter or folder (VirtualCenter Server) is selected in the inventory panel (see “Inventory Panel” on page 25), you can view a list of all the virtual machines the selected object contains. When a virtual machine is selected, the workspace provides detailed information about various aspects of the virtual machine.

- **Menu bar** – The menu items along the top of the VI Web Access window provide access to common virtual machine operations, such as power on and enter full screen mode.

- **Toolbar** – The buttons along the top allow you to perform actions on the selected virtual machine, offering one-click access to operations such as power on and entering full screen mode.
Workspace

When you select a virtual machine, the workspace provides detailed information about various aspects of the virtual machine. You can view a summary of the virtual machine’s state, interact with the guest operating system by using a remote mouse, keyboard, screen (MKS), and view details about alarms (VirtualCenter), events, and tasks (VirtualCenter).

Figure 3-2. Virtual Machine Information Panel

Administrators can configure a URL for any virtual machine that displays only the Remote Console tab, allows or disables access to the virtual machine and its Workspace tabs, and that allows or disables access to the entire virtual machine inventory. See “Creating and Sharing Remote Console URLs” on page 35.
Menu Bar
The menu bar provides access to all commands. The menu bar options are:

- **Web Access** – Displays options relevant to VI Web Access.
- **View** – Controls which panes are visible.
- **Virtual Machine** – Enabled only when a virtual machine is selected in the inventory panel.

**Web Access Menu**
The **Web Access** menu lists general VI Web Access options for getting help and logging out.

- **About** – Displays the Web Access version number, the ESX Server or VirtualCenter Server version number, and VMware copyright information.
- **Help** – Displays the online help contents.
- **Log Out** – Logs you out of VI Web Access.

**View Menu**
The virtual machine **View** menu lists options for managing inventory and tab views on the VI Web Access home page.

**Inventory Options**
Inventory options include:

- **Expand Sidebar** – Expands the inventory panel.
- **Collapse Sidebar** – Collapses the inventory panel. When collapsed, the inventory panel is a strip along the left side of the VI Web Access window. Click the arrows in the strip to expand or collapse the inventory panel.
- **Hide Sidebar** – Hides the inventory panel. When the inventory panel is hidden, you cannot access the inventory panel unless you deselect this view option.

**Virtual Machine Tab Options**
The virtual machine tabs appear at the top of the workspace. Display options include:

- **Show Tabs** – Displays the **Summary**, **Events**, **Alarms** (VirtualCenter only), **Tasks** (VirtualCenter only), and **Console** tabs for the virtual machine.
- **Hide Tabs** – Hides the **Summary**, **Events**, **Alarms** (VirtualCenter only), **Tasks** (VirtualCenter only), and **Console** tabs for the virtual machine.
Virtual Machine Menu
The Virtual Machine menu lists options for managing the power state of a virtual machine and for viewing the console.

The menu includes the following commands, some of which you can perform by using the buttons and other visual elements of the management interface:

- **Power On** – Powers on a stopped virtual machine.
- **Resume** – Resumes a suspended virtual machine.
- **Power Off** – Powers off the virtual machine immediately. This is the same as turning off the power to a physical computer.
- **Suspend** – Suspends a powered-on virtual machine.
- **Reset** – Resets the virtual machine immediately. This is the same as pressing the reset button on a physical computer.
- **Shutdown Guest** – Shuts down the guest operating system.
- **Restart Guest** – Restarts the guest operating system and the virtual machine.
- **Enter Full Screen Mode** – Puts the virtual machine console in full screen mode.
- **Send Ctrl+Alt+Del** – Sends the Ctrl+Alt+Del key combination to the virtual machine.

Toolbar
The toolbar at the top of the VI Web Access page contains buttons you can click to power your virtual machines on and off.

The following table describes the toolbar actions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="red_icon.png" alt="Red Icon" /></td>
<td>Depending on how you configured the power options for this virtual machine, this button either shuts down the guest operating system or powers off the virtual machine (see “Changing Power State Options” on page 63). When this icon is red, the virtual machine is powered off.</td>
</tr>
<tr>
<td><img src="amber_icon.png" alt="Amber Icon" /></td>
<td>Suspends a running virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is amber, the virtual machine is suspended.</td>
</tr>
<tr>
<td><img src="green_icon.png" alt="Green Icon" /></td>
<td>Powers on a stopped virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is green, the virtual machine is running.</td>
</tr>
</tbody>
</table>
## Inventory Panel

This panel displays the virtual machine inventory. You can collapse and expand the inventory panel with a single click.

Administrators can configure a URL that does not show the inventory panel.

<table>
<thead>
<tr>
<th>Button</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Restart/Reset" /></td>
<td>Depending on how you configured the power options for this virtual machine, this button either restarts the guest operating system or resets the virtual machine (see “Changing Power State Options” on page 63).</td>
</tr>
<tr>
<td><img src="image" alt="Enlarges" /></td>
<td>Enlarges the virtual machine display to cover the entire Web Access window. This option is enabled only when a virtual machine is running and the <strong>Console</strong> tab is selected.</td>
</tr>
<tr>
<td><img src="image" alt="Network" /></td>
<td>Takes you to the network adapter configuration page. A red X over the icon indicates that the network adapter is not connected.</td>
</tr>
<tr>
<td><img src="image" alt="CD/DVD Drive" /></td>
<td>Takes you to the CD/DVD Drive configuration page. A red X over the icon indicates that the CD/DVD Drive is not connected.</td>
</tr>
<tr>
<td><img src="image" alt="Disk Drive" /></td>
<td>Takes you to the disk drive configuration page. A red X over the icon indicates that the disk drive is not connected.</td>
</tr>
</tbody>
</table>
Using Virtual Infrastructure Web Access to Manage Virtual Machines

This chapter describes the various aspects of using VI Web Access to manage virtual machines. This chapter contains the following sections:

- “Summary, Events, Alarms, Tasks, and Console Views” on page 27
- “Viewing Summary Information About Virtual Machines” on page 28
- “Viewing Virtual Machine Events” on page 29
- “Viewing Virtual Machine Alarms” on page 30
- “Viewing Virtual Machine Tasks” on page 30
- “Using the Console” on page 31
- “Installing VMware Tools in the Guest Operating System” on page 33
- “Changing the Power State of a Virtual Machine” on page 34
- “Creating and Sharing Remote Console URLs” on page 35

Summary, Events, Alarms, Tasks, and Console Views

The tabs on the workspace, which appears on the right side of the VI Web Access display, displays information about the selected virtual machine.

- **Summary** – Displays performance and status information. From this tab, you can modify the selected virtual machine’s hardware and configuration options.
- **Events** – Displays events that occurred for the virtual machine. Select an event to see its details in the **Event Details** field.
- **Alarms** – Displays alarms. This tab is available only through VirtualCenter Server.
Tasks – Displays activities and activity details. This tab is available only when using VI Web Access to connect to a VirtualCenter Server. Tasks can be initiated manually or scheduled by using the VI Client. Select a task to see its details in the Task Details field.

Console – Allows users to interact directly with the guest operating system. See “Using the Console” on page 31.

Viewing Summary Information About Virtual Machines

The Summary tab for a virtual machine displays a summary of the configuration information about that virtual machine.

Figure 4-1. Virtual Machine Summary Tab
The summary page contains the following information:

- Amount of server processor capacity that the virtual machine is using.
- Amount of server memory that the virtual machine is using.
- Power state of the virtual machine: whether it is powered on, powered off, or suspended. See “Changing the Power State of a Virtual Machine” on page 34.
- Guest operating system installed in the virtual machine.
- VMware Tools status, indicating whether VMware Tools is installed and running. A link to install or upgrade VMware Tools appears when Tools is not installed or needs to be upgraded to the latest version. See “Installing VMware Tools in the Guest Operating System” on page 33.
- IP address and DNS name of the virtual machine.
- Links to edit or remove the virtual machine’s hardware. To change most options, power off the virtual machine. See “Editing the Hardware Configuration of a Virtual Machine” on page 38.
- Links to add hardware to the virtual machine. See “Adding Hardware to a Virtual Machine” on page 50.
- Links to edit the virtual machine’s standard configuration options. To change most options, power off the virtual machine. See “Changing Virtual Machine Options” on page 62.
- Link to create a remote console URL of the virtual machine. See “Creating and Sharing Remote Console URLs” on page 35.
- Current relationships of the virtual machine: the name of the virtual machine’s host, datastores, and networks.
- Recent tasks for the virtual machine.
- Recent alarms for the virtual machine, when you are using VI Web Access to connect to a VirtualCenter Server.

**Viewing Virtual Machine Events**

The Events tab is available when you select a virtual machine from the inventory panel. The Events panel displays a sorted log of the most recent virtual machine transactions, such as questions that ESX Server asks, errors, and other events like powering on or powering off the virtual machine.
You can sort events by clicking on the column headers. By default, events appear in reverse chronological order.

The event log draws its data from the log file for the virtual machine’s configuration file. The log file is stored, by default, in the directory where the virtual machine is stored.

The Events tab content is described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered</td>
<td>Date and time the event occurred</td>
</tr>
<tr>
<td>Triggered By</td>
<td>Entity that triggered the event</td>
</tr>
<tr>
<td>Type</td>
<td>Type of event that occurred</td>
</tr>
<tr>
<td>Message</td>
<td>Text explanation of action</td>
</tr>
</tbody>
</table>

Viewing Virtual Machine Alarms

If you are using VI Web Access to connect to a VirtualCenter Server, the Alarms tab is available when you select a virtual machine from the inventory panel. Alarms are notifications that are triggered when specified events happen to a virtual machine, such as CPU usage exceeding the designated usage.

The Alarms tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Triggered</td>
<td>Date and time the alarm was most recently triggered</td>
</tr>
<tr>
<td>Status</td>
<td>Severity of the alarm</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the alarm</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the alarm</td>
</tr>
</tbody>
</table>

Viewing Virtual Machine Tasks

If you are using VI Web Access to connect to a VirtualCenter Server, the Tasks tab is available when you select a virtual machine from the inventory panel. Tasks are high-level actions, such as powering on a virtual machine, that the user performs manually or that are performed automatically on a schedule. Click a task’s triggered date and time to display its details, including related events, in the Task Details section.
Chapter 4 Using Virtual Infrastructure Web Access to Manage Virtual Machines

The **Task** tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered</td>
<td>Date and time the task started</td>
</tr>
<tr>
<td>Triggered By</td>
<td>User or entity that initiated the task</td>
</tr>
<tr>
<td>Status</td>
<td>The state of the task: queued, in progress, error, or success</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the task</td>
</tr>
</tbody>
</table>

**Using the Console**

The **Console** tab is available when you select a virtual machine from the inventory panel. To interact with the guest operating system running in a virtual machine, use the **Console** tab to connect remotely to the virtual machine's mouse, keyboard, and screen (MKS).

When a virtual machine is powered off, suspended, or not available, or if the MKS plug-in is not installed, the **Console** tab displays a message and possible actions for the virtual machine.

Virtual machine states include:

- **Powered Off** – The virtual machine is powered off.
- **Suspended** – The virtual machine is suspended.
- **Not Available** – The virtual machine is unavailable.
- **Powering Off** – The virtual machine is in the process of powering off.
- **Powering On** – The virtual machine is in the process of powering on.
- **Suspending** – The virtual machine is in the process of suspending.
When the virtual machine is powered on, the **Console** tab displays the MKS of the virtual machine.

**Figure 4-2. Virtual Machine Console**

To interact with the guest operating system by using your mouse or keyboard, click the virtual machine’s screen. To transfer control of your mouse and keyboard to your computer, press Ctrl+Alt. If you have VMware Tools installed on the virtual machine, you can move the cursor in and out of the virtual machine to quickly switch mouse and keyboard control between the virtual machine and your computer.
Entering Full Screen Mode

The Console tab has a full screen option. Select this option by clicking the full screen mode toolbar button ( fullscreen ) or by pressing Ctrl+Alt+Enter. This option is enabled only when a virtual machine is running and the Console tab is selected.

To exit full screen mode, press and release Ctrl+Alt.

Installing VMware Tools in the Guest Operating System

VMware Tools is a suite of utilities that improves the performance of guest operating systems and enhances virtual machine management. For best results, VMware strongly recommends that you install VMware Tools in all of your guest operating systems.

After your guest operating system is installed on a virtual machine, use the following procedure to install or upgrade VMware Tools.

To install VMware Tools

1 In the status section of a virtual machine’s summary, choose Install VMware Tools.
2 Use the console to complete the installation.
   This step connects the virtual machine's CD drive to an installation file on the ESX Server machine or the VirtualCenter Server. If autorun is enabled in your guest operating system (the default setting for Windows operating systems), a dialog box appears after a few seconds. It asks if you want to install VMware Tools. Click Install to start the Installation wizard.
3 Click the Console tab.
4 Restart the guest operating system when prompted.

To upgrade VMware Tools

1 In the status section of a virtual machine’s summary, click Upgrade VMware Tools.
2 Use the console to complete the installation.
3 On a Windows guest, restart the guest operating system to complete the upgrade.
Changing the Power State of a Virtual Machine

Depending on your permissions, you can use VI Web Access to change the power state of the virtual machine. To change a virtual machine’s power state, click the button in the toolbar that indicates the desired power state.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power Off" /></td>
<td>Powers off the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server might shut down the guest operating system before powering off the virtual machine (see “Changing Power State Options” on page 63). When this icon is red, the virtual machine is powered off.</td>
</tr>
<tr>
<td><img src="image" alt="Suspend/Resume" /></td>
<td>Suspends a running virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is amber, the virtual machine is suspended.</td>
</tr>
<tr>
<td><img src="image" alt="Power On" /></td>
<td>Powers on a stopped virtual machine or resumes a suspended virtual machine. VMware Tools executes the script associated with this power state change, if any. When this icon is green, the virtual machine is running.</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td>Resets the virtual machine. Depending on how you have configured the power options for this virtual machine, ESX Server might shut down the guest operating system before resetting the virtual machine (see “Changing Power State Options” on page 63).</td>
</tr>
</tbody>
</table>

**NOTE** Shutting down or restarting a guest operating system works only when VMware Tools is installed. Otherwise, the power is turned off or the virtual machine is reset exactly as if you had pushed the power or reset button on a physical machine.

For information on installing VMware Tools, see “Installing VMware Tools in the Guest Operating System” on page 33.
Creating and Sharing Remote Console URLs

Using VI Web Access, you can create a remote console URL of a virtual machine by using standard Web browser URLs. When creating a remote console URL, you can customize the VI Web Access user interface controls. Using remote console URLs, you can:

- Add the remote console URL to a list of favorite Web pages
- Share the remote console URL with one or more users in an e-mail message

**NOTE** Administrators wishing to test a remote console URL should do so by using a different browser or computer. If the remote console URL is tested on the administrator's active browser session, all instances of that browser needs to be closed before the administrator can log back in with full user interface capabilities.

**To create a virtual machine remote console URL**

1. In the status section of a virtual machine’s summary, click Generate Remote Console URL.
2. Choose user interface features.
   - You can allow or disallow full inventory and Workspace tab viewing.
3. Copy the remote console URL for further use.
4. Click Close.
Editing an Existing Virtual Machine’s Configuration

This chapter describes the various aspects of using VI Web Access to configure virtual machines. This chapter contains the following sections:

- “Editing the Configuration of Existing Virtual Machines” on page 37
- “Understanding Permissions and Virtual Machines” on page 37
- “Using Client Devices” on page 38
- “Editing the Hardware Configuration of a Virtual Machine” on page 38
- “Adding Hardware to a Virtual Machine” on page 50
- “Changing Virtual Machine Options” on page 62

Editing the Configuration of Existing Virtual Machines

To see more information about a virtual machine and to modify its configuration, click the virtual machine in the Inventory panel. The Summary tab displays the activities you can perform when viewing a virtual machine's details.

Understanding Permissions and Virtual Machines

Access to a virtual machine is based on the permissions you, as a user, are granted to the virtual machine's configuration file. Different permissions let you access virtual machines in different ways, including the following:

- Browsing
- Interacting
Configuring
Administering

Depending on your permissions and the state of the virtual machine, some options might not be available.

Permissions are configured by using the Virtual Infrastructure Client. See the VMware Infrastructure Basic System Administration Guide.

Using Client Devices

With ESX Server 3, you can connect some virtual devices to physical devices or ISO images on the client machine. This is useful if to have users use physical drives on their local machines rather than on the host system, or to have the virtual machine access an ISO image on the client computer.

Client devices are currently supported for CD/DVD and disk drives.

CAUTION  When using client devices in a Linux guest, make sure that the device you are connecting to is not mounted or in use. If left mounted, the physical device cannot connect to the client device.

Editing the Hardware Configuration of a Virtual Machine

The Hardware list on the virtual machine Summary tab lists the virtual hardware in the virtual machine, such as memory, hard disks, CD/DVD drives, and network adapters. You can configure each hardware component, but in some cases the virtual machine must be powered off to edit all of the component's options.

Editing Processors

You can change the number of virtual processors used by your virtual machine.

To change the number of processors used
1 Select the virtual machine to modify from the inventory panel.
2 Make sure the virtual machine is powered off.
3 On the Summary tab, click Processors.
4 Click Edit.
5 Choose the number of processors you would like for the virtual machine from the Processor Count drop-down menu.
6 Click OK.
Chapter 5  Editing an Existing Virtual Machine’s Configuration

**Editing Memory Configuration**

Using VI Web Access, you can modify the memory allocation for each virtual machine.

**To edit Memory allocation**

1. Select the virtual machine to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary tab, click Memory.
4. Click Edit.
5. To ensure that the virtual machine will boot, allocate at least the recommended minimum memory.
6. Click OK.

**Editing or Removing a CD/DVD Drive**

Virtual machines can access physical CD/DVD drives on either the ESX Server host where the virtual machine is running or on your computer. They can access ISO images on the ESX Server file system or on remote datastores.

**To edit an existing CD/DVD drive**

1. Select the virtual machine to modify from the inventory panel.
2. On the Summary tab, click the CD/DVD drive to modify.
3. The media source machine is selected.

   Select an action:
   - To connect the CD/DVD Drive to the ESX Server devices or files, select **Host Media**.
   - To connect the CD/DVD Drive to devices on your computer, click **Client Media**.

   **Client Media** is supported on ESX Server 3 virtual machines only. See “Using Client Devices” on page 38.

   The remainder of the dialog box contents changes to accommodate the capabilities of the selected media source. For example, virtual machines cannot connect to client media while powering on. Consequently, **Connect at power on** is disabled if the Client Media option is selected.
To connect this virtual machine to the server's CD/DVD drive when the virtual machine is powered on, select **Connect at power on**.

Specify whether to connect to the server’s CD/DVD Drive or to an ISO image by selecting **Physical Drive** or **ISO Image**.

Enter the location of the drive in the **Physical Drive** field or the location of the ISO image in the **ISO Image** field.

For example, the server’s CD drive could be `/dev/cdrom`.

Select the IDE device node from the **IDE Device Node** list.

Click **OK**.

When you click **OK** after connecting the drive to **Client Media**, a Device Status window appears. This window must remain open to keep the client device connected. Turn off pop-up blocking on your browser before connecting a drive to client media.

**To remove an existing CD/DVD drive**

1. Select the virtual machine to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the **Summary** tab, click the CD/DVD drive to remove.
4. Click **Remove**.

**Editing or Removing a Disk Drive**

Use VI Web Access to edit disk drives attached to virtual machines. Each virtual machine can access a physical disk drive or a disk image file on the host machine or on the client machine where you are running your browser. You can connect only one disk drive to each physical drive on the client computer. A device can be connected to only one virtual machine on a server at a time.

**To edit an existing disk drive**

1. Select the virtual machine to modify from the inventory panel.
2. In the **Summary** tab, click the disk drive to remove.
3. Click **Edit**.
Choose the media type for the disk drive:

- **Host Media** – Connects to a device or file on the host system.
- **Client Media** – Connects to a device or file on the client system.

**Client Media** is supported on ESX 3 virtual machines only. See “Using Client Devices” on page 38.

5 To connect this virtual machine to the server’s disk drive, select **Connected**.

Only one virtual machine can connect to a given disk drive at a time.

To connect this virtual machine to the server’s disk drive when the virtual machine is powered on, select **Connect at power on**.

6 To specify whether to connect to the server’s disk drive or to a disk image, select **Physical Drive** or **Floppy Image**.

7 Enter the location of the drive or disk image in the location field.

For example, the server’s disk drive could be /dev/fd0.

8 Click **OK**.

When you click **OK** after connecting the drive to **Client Media**, a Device Status window appears. This window must remain open to keep the client device connected. Turn off pop-up blocking on your browser before connecting a drive to client media.

**To remove an existing disk drive**

1 Select the virtual machine to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the **Summary** tab, click the disk drive to modify.

4 Click **Remove** to remove the disk drive from the virtual machine, or click **Delete from Disk** to remove the Floppy Image from the virtual machine and delete the file from the host computer.
Editing or Removing a Hard Disk

Using VI Web Access, you can edit a virtual hard disk's configuration, remove it from the virtual machine, or delete it from your ESX Server host.

To edit an existing virtual disk on an ESX 3 virtual machine

1. Select the virtual machine to modify from the inventory panel.
2. On the Summary tab, click the hard disk to modify.
3. Click Edit.
4. Select the SCSI Device Node from the drop-down menu.
   - If the hard disk you are configuring is the boot device for this virtual machine, click Modify the Device’s SCSI Node to change the SCSI device node.
5. If you choose to use the disk in Independent mode, select Persistent or Nonpersistent disk mode:
   - Persistent – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode is written out permanently to the disk.
   - Nonpersistent – Changes to disks in nonpersistent mode are not saved to the disks. Changes are lost when the virtual machine is powered off or reset.
     Nonpersistent mode is convenient for users who always want to start with a virtual machine in the same state every time they virtual machine is powered on. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.
6. Click OK.

To edit an existing virtual disk on an ESX 2.x virtual machine

1. Select the virtual machine to modify from the inventory panel.
2. On the Summary tab, click the hard disk to modify.
3. Click Edit.
4. Select SCSI Device Node from the drop-down menu.
   - If the hard disk you are configuring is the boot device for this virtual machine, click Modify the Device’s SCSI Node to change the SCSI Device node.
5 Choose the disk mode:

- **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.

- **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.

  Nonpersistent mode is for users who want to start with a virtual machine in the same state. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

- **Undoable** – Changes to disks in undoable mode can be saved, discarded, or appended when the virtual machine powers off.

- **Append** – Changes to disks in append mode are preserved in a redo log attached to the virtual disk.

6 Click OK.

**To edit an existing system LUN disk on an ESX 3 virtual machine**

1 Select the virtual machine to modify from the inventory panel.

2 On the **Summary** tab, click the hard disk to modify.

3 Click **Edit**.

4 Select the **SCSI Device Node** from the drop-down menu.

   If the hard disk you are configuring is the boot device for this virtual machine, click **Modify the Device’s SCSI Node** to change the SCSI Device node.

5 If you choose to use the disk in Independent mode, select **Persistent** or **Nonpersistent** disk mode:

- **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode is written out permanently to the disk.

- **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks. Changes are lost when the virtual machine is powered off or reset.

  Nonpersistent mode is convenient for users who always want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

6 Click **OK**.
To edit an existing system LUN disk on an ESX 2.x virtual machine

1 Select the virtual machine to modify from the inventory panel.
2 On the Summary tab, click the hard disk to modify.
3 Click Edit.
4 Select SCSI Device Node from the drop-down menu.
   If the hard disk you are configuring is the boot device for this virtual machine, click Modify the Device's SCSI Node to change the SCSI Device node.
5 Choose the Disk Mode:
   ■ **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
   ■ **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.
   Nonpersistent mode is for users who want to start with a virtual machine in the same state each time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.
   ■ **Undoable** – Changes to disks in undoable mode can be saved, discarded, or appended when the virtual machine powers off.
   ■ **Append** – Changes to disks in append mode are preserved in a redo log attached to the virtual disk.
6 Click OK.

To remove an existing hard disk

1 Select the virtual machine to modify from the inventory panel.
2 Make sure the virtual machine is powered off.
3 On the Summary tab, click the hard disk to remove.
4 Click Remove to remove the hard disk from the virtual machine, or click Delete from Disk to remove the hard disk from the virtual machine and delete the virtual disk file from the host computer.
Editing or Removing a SCSI Device

Using VI Web Access, you can edit a SCSI device’s configuration or remove it from the virtual machine.

**To edit an existing SCSI Device**
1. Select the virtual machine to modify from the inventory panel.
2. On the Summary tab, click the SCSI device to modify.
3. Click Edit.
4. Use the Connection drop-down menu to specify the physical device to use.
5. Use the Virtual Device drop-down menu to specify the SCSI device node.
6. Click OK.

**To remove an existing SCSI Device**
1. Select the virtual machine to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary tab, click the SCSI Device to remove.
4. Click Remove.

Editing a SCSI Controller

Using VI Web Access, you can edit a SCSI controller’s configuration or remove it from the virtual machine.

**To edit a SCSI controller’s configuration**
1. Select the virtual machine to modify from the inventory panel.
2. On the Summary tab, click the SCSI controller to modify. Click Edit.
3. Select the SCSI controller type in the list.
   Changing the SCSI controller type might prevent the virtual machine from booting.
4 To specify whether the SCSI bus is shared, select the type of sharing in the SCSI Bus Sharing section:
- None – Virtual disks cannot be shared by other virtual machines.
- Virtual – Virtual disks can be shared by virtual machines on the same server.
- Physical – Virtual disks can be shared by virtual machines on any server.

Depending upon the type of sharing, virtual machines can access the same virtual disk simultaneously on the same server or any server.

5 Click OK.

**Editing or Removing a Network Adapter**

You can connect virtual network adapters to a labeled network in much the same way that you connect physical network adapters by cables to wall jacks. By choosing a labeled network for an adapter, you enable the guest operating system to reach the resources of the specified network.

**To edit an existing network adapter on an ESX 3 virtual machine**

1 Select the virtual machine to modify from the inventory panel.
2 On the Summary tab, click the network adapter to modify.
3 Click Edit.

![Network Adapter Edit Window](image)

4 To connect this virtual machine to the network when the virtual machine is powered on, select Connect at power on.

5 In the Network Connection list, select the virtual network device to use.

6 Click OK.
Chapter 5  Editing an Existing Virtual Machine’s Configuration

To edit an existing network adapter on an ESX 2.x virtual machine

1. Select the virtual machine to modify from the inventory panel.
2. On the Summary tab, click the Network Adapter to modify.
3. Click Edit.

![Network Adapter Configuration](image)

4. To connect this virtual machine to the network when the virtual machine is powered on, select Connect at power on.
5. In the Network Connection list, select the virtual network device for the virtual machine to use.
6. In the Virtual Device list, select the network driver for the virtual machine to use. Choose either the `vlance` or `vmxnet` driver.
7. Click OK to add the Network Adapter and return to the Summary tab.

To remove an existing network adapter

1. Select the virtual machine to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the Summary tab, click the network adapter to remove.
4. Click Remove.
Editing or Removing a Parallel Port

Using VI Web Access, you can edit the configuration of an existing parallel port or remove it from the virtual machine.

**To edit an existing parallel port**

1. From the VI Web Access client, select the virtual machine.
2. On the **Summary** tab, click the parallel port to modify.
3. Click **Edit**.
4. Under **Device status**, the default setting is **Connect at power on**.
5. Select the **Connection Type**.
   - **Physical** – from the drop-down menu, select the port to use on the end user’s host machine.
   - **File** – Type the path and filename, or browse to the location of the file.
6. Click **OK**.

**To remove an existing Parallel Port**

1. Select the virtual machine to modify from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the **Summary** tab, click the parallel port to remove.
4. Click **Remove**.

Editing or Removing a Serial Port

You can set up the virtual serial port in a virtual machine to use a physical Serial Port on the host computer. This is useful, for example, to use a modem or a handheld device in your virtual machine.

**To edit an existing Serial Port**

1. Select the virtual machine to modify from the inventory panel.
2. On the **Summary** tab, click the serial port to modify.
3. Click **Edit**.
4. To connect the Serial port to the virtual machine when power is on, select **Connect at power on**.
5 Choose the connection type.

- **Physical** – from the drop-down menu, select the port to use on the end user’s host machine.

- **File** – Type the path and filename, or browse to the location of the file.

- **Named Pipe** – type the pipe name and use the drop-down list to choose the connection options.

  i Under **Near End**, choose whether the application running in the guest operating system will function as a server or a client.

  - Select **Is a server** to start this end of the connection first.
  - Select **Is a client** to start the far end of the connection first.

  ii Under **Far End**, specify the location of the application the virtual machine will connect to.

  - Select **Is a virtual machine** if the application that the virtual machine will connect to is located on another virtual machine on the host.
  - Select **Is an application** if the application that the virtual machine will connect to is on the host machine.

6 Under **I/O Mode**, select whether to **Yield CPU on poll**.

   The kernel in the target virtual machine uses the virtual serial port in polled mode, not interrupt mode.

7 Click **OK**.

**To remove an existing Serial Port**

1 Select the virtual machine to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the **Summary** tab, click the serial port to remove.

4 Click **Remove**.
Adding Hardware to a Virtual Machine

Add virtual hardware to a virtual machine by using the Add Hardware wizard.

To start the wizard
1. From VI Web Access, select the virtual machine.
2. On the Summary tab, under Commands, click Add Hardware.
3. Select the type of hardware to add and click Next.
4. Follow the steps in the wizard.

Adding a Hard Disk

You can add a new virtual disk, an existing virtual disk, or a mapped system LUN to the virtual machine.

To add a new virtual disk to an ESX 3 virtual machine
1. Select a virtual machine from the inventory panel.
2. On the Summary tab, under Commands, click Add Hardware.
3. Select Hard Disk and click Next.
4. Select Create a new virtual disk, and click Next.
5. Specify the Capacity of the disk.
6. Disk Size must be specified in integers.
7. Choose the Location of the virtual disk:
   - Select Use the virtual machine’s datastore to install the virtual disk in the same location as the virtual machine.
   - Select Use a specific datastore to specify a location to install the virtual disk. Specify the datastore location by entering the path to the virtual disk, or click Browse and navigate to the datastore to use.
8. Click Next.
9. Select the SCSI Device Node from the drop-down menu.
10. Choose whether or not to run the disk in Independent Mode.
    Disks in independent mode are not affected by snapshots.
If you selected **Independent Mode**, choose one of the following:

- **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.

- **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

Click **Next**.

Review the device configuration summary and click **Finish**.

**To add a new virtual disk to an ESX 2.x virtual machine**

1. Select a virtual machine from the inventory panel.
2. Make sure the virtual machine is powered off.
3. On the **Summary** tab, under **Commands**, click **Add Hardware**.
4. Select **Hard Disk** and click **Next**.
5. Select **Create a new virtual disk** and click **Next**.
6. Specify the size and location of the disk.
   - Disk size must be specified in integers.
7. Specify the datastore location by entering the path to the virtual disk, or click **Browse** and navigate to the datastore to use.
8. Click **Next**.
9. Select the **SCSI Device Node** from the drop-down menu.
10. Choose the **Disk Mode**:

- **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.

- **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.
Nonpersistent mode is for users who want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

- **Undoable** – Changes to disks in undoable mode can be saved, discarded, or appended when the virtual machine powers off.
- **Append** – Changes to disks in append mode are preserved in a redo log attached to the virtual disk.

11 Click Next.

12 Review the device configuration summary and click Finish.

**To add an existing virtual disk to an ESX 3 virtual machine**

1 Select a virtual machine from the inventory panel.

2 If you are adding a hard disk to an ESX Server 2.x virtual machine, make sure the virtual machine is powered off.

3 On the Summary tab, under Commands, click Add Hardware.

4 Select Hard Disk and click Next.

5 Select **Use an existing virtual disk** and click Next.

6 Browse to and select an existing virtual disk and click Next.

7 Select the **SCSI Device Node** from the drop-down menu.

8 If you select **Independent Mode**, select **Persistent** or **Nonpersistent** disk mode:

- **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
- **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.

9 Click Next.

10 Review the device configuration summary and click Finish.
Chapter 5   Editing an Existing Virtual Machine's Configuration

To add an existing virtual disk to an ESX 2.x virtual machine

1. Select a virtual machine from the inventory panel.
2. If you are adding a hard disk to an ESX Server 2.x virtual machine, make sure the virtual machine is powered off.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select Hard Disk and click Next.
5. Select Use an existing virtual disk and click Next.
6. Browse to and select an existing virtual disk and click Next.
7. Select the SCSI Device Node from the drop-down menu.
8. Choose the Disk Mode:
   - **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
   - **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.
     Nonpersistent mode is for users who want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.
   - **Undoable** – Changes to disks in undoable mode can be saved, discarded, or appended when the virtual machine powers off.
   - **Append** – Changes to disks in append mode are preserved in a redo log attached to the virtual disk.
9. Click Next.
10. Review the device configuration summary and click Finish.

To add a mapped system LUN to an ESX 3 virtual machine

1. Select a virtual machine from the inventory panel.
2. If you are adding a hard disk to an ESX Server 2.x virtual machine, make sure the virtual machine is powered off.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select Hard Disk and click Next.
5 Select **Use a mapped system LUN** and click **Next**.
6 Select the LUN to add to the virtual machine, and click **Next**.
7 Choose the file location:
   - **Use the virtual machine’s datastore** – Install the virtual disk in the same location as the virtual machine.
   - **Use a specific datastore** – Specify a location in which to install the virtual disk.
8 Click **Next**.
9 Select the **SCSI Device Node** from the drop-down menu.
10 Choose the disk **Compatibility**:
   - **Physical** – Allow the guest operating system to access the storage hardware directly.
   - **Virtual** – Allow the virtual machine to take advantage of the features of virtual disks, such as snapshots and disk modes. For more information about virtual disks, see the Basic System Administration Guide.
11 If you choose virtual compatibility, choose whether to run the disk in **Independent Mode**.
12 If you select **Independent Mode**, choose **Persistent** or **Nonpersistent** disk mode:
   - **Persistent** – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
   - **Nonpersistent** – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.
     Nonpersistent mode is for users who want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.
   - **Undoable** – Changes to disks in undoable mode can be saved, discarded, or appended when the virtual machine powers off.
   - **Append** – Changes to disks in append mode are preserved in a redo log attached to the virtual disk.
13 Click **Next**.
14 Review the device configuration summary and click **Finish**.
To add a mapped system LUN to an ESX 2.5.x virtual machine

1 Select a virtual machine from the inventory panel.

2 If you are adding a hard disk to an ESX Server 2.x virtual machine, make sure the virtual machine is powered off.

3 On the Summary tab, under Commands, click Add Hardware.

4 Select Hard Disk and click Next.

5 Select Use a mapped system LUN and click Next.

6 Select the LUN to add to the virtual machine and click Next.

7 Browse to the location where to install the virtual disk and click Next.

8 Select the SCSI Device Node from the drop-down menu.

9 Choose the disk Compatibility:
   - Physical – Allow the guest operating system to access the storage hardware directly.
   - Virtual – Allow the virtual machine to take advantage of disk modes and other features of virtual disks.

10 If you choose virtual compatibility, choose the Disk Mode:
   - Persistent – Disks in persistent mode behave like conventional disk drives on your physical computer. All data written to a disk in persistent mode are written out permanently to the disk.
   - Nonpersistent – Changes to disks in nonpersistent mode are not saved to the disks, but are lost when the virtual machine is powered off or reset.
     Nonpersistent mode is for users who want to start with a virtual machine in the same state every time they start the virtual machine. Example uses include providing known environments for software test and technical support users, as well as demonstrating software.
   - Undoable – Changes to disks in undoable mode can be saved, discarded, or appended when the virtual machine powers off.
   - Append – Changes to disks in append mode are preserved in a redo log attached to the virtual disk.

11 Review the device configuration summary and click Finish.
Adding a Network Adapter

Using VI Web Access, you can add virtual network adapters to a virtual machine.

To add a Network Adapter
1. Select a virtual machine from the inventory panel.
2. On the Summary tab, under Commands, click Add Hardware.
3. Select Network Adapter and click Next.
4. Select the network interface card.
   To have the network adapter connected to the virtual machine when you power it on, select Connect at power on.
5. Click Next.
6. Click Finish.

Adding a CD/DVD Drive

You can add up to four CD/DVD drives to your virtual machine. You can connect the virtual machine’s drive to a physical drive or ISO image on your host machine or on the machine where you are running your browser.

To add a CD/DVD drive to a virtual machine
1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select CD/DVD Drive and click Next.
5. Choose a Media Type option:
   - Select a Host Media option to connect to a drive or ISO image on the ESX host.
   - Use a physical drive – connects the virtual machine’s drive to a physical drive on the host computer.
   - Use an ISO image – connects the virtual machine’s drive to an ISO image file on the host computer.
Chapter 5 Editing an Existing Virtual Machine’s Configuration

- Select a **Client Media** option to connect to a drive or ISO image on the client computer.
- **Use a physical drive** – connects the virtual machine's drive to a physical drive on the client computer.
- **Use an ISO image** – connects the virtual machine's drive to an ISO image file on the client computer.

Client Media options are not available on ESX 2.x virtual machines.

6 Click Next.

7 If you selected **Use a physical drive**, specify the drive to use and indicate whether the system should connect the device when the virtual machine powers on.

8 Click Next.

9 If you selected **Use an ISO image**, type the path and filename for the image file or click **Browse** to navigate to the file.

   To have the drive connected to the virtual machine when you power it on, select **Connect at power on**.

10 Click Next.

11 Choose the virtual device node from the drop-down menu.

12 Click Next.

13 Click Finish.

**Adding a Disk Drive**

You can connect a disk drive in your virtual machine to a physical drive or floppy image on the host machine or on the machine where you are running your browser.

To add a new virtual disk drive to a virtual machine

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 On the **Summary** tab, under **Commands**, click **Add Hardware**.

4 Select **Floppy Drive** and click **Next**.
5 Choose one of the **Media Type** options:

- Select a **Host Media** option to connect to a drive or floppy image on the ESX host.
  - **Use a physical drive** – connects the virtual machine’s drive to a physical drive on the host computer.
  - **Use an existing floppy image** – connects the virtual machine’s drive to a floppy image file on the host computer.
  - Select **Create a blank floppy image** to connect the virtual machine’s drive to a new, blank floppy image file on the host computer.

- Select a **Client Media** option to connect to a drive or floppy image on the client computer.
  - **Use a physical drive** – connects the virtual machine’s drive to a physical drive on the client computer.
  - **Use an existing floppy image** – connects the virtual machine’s drive to a floppy image file on the client computer.
  - **Create a blank floppy image** – connects the virtual machine’s drive to a new, blank floppy image file on the client computer.

Client Media options are not available on ESX 2.x virtual machines.

6 Click **Next**.

7 Select the type of floppy media.

   To have the disk drive connected to the virtual machine when you power it on, select **Connect at power on**. Connecting at power on is not available with client media.

8 Click **Finish**.

**Adding a Serial Port**

You can set up the virtual serial port in a virtual machine to use a physical serial port on the host computer, an output file on the host computer, or an application running in the virtual machine or another virtual machine on the host computer.
To add a physical serial port to the virtual machine’s configuration
1 Make sure the virtual machine is powered off.
2 Select a virtual machine from the inventory panel.
3 On the Summary tab, under Commands, click Add Hardware.
4 Select Serial Port and click Next.
5 Choose Use a physical serial port to connect to a physical port on the host machine and click Next.
6 To connect this virtual machine to the host’s serial port when the virtual machine is powered on, select Connect at power on and click Next.
7 Under I/O Mode, select whether to Yield CPU on poll.
   The kernel in the target virtual machine uses the virtual serial port in polled mode, not interrupt mode.
8 Click Next.
9 Click Finish.

To add an output file Serial Port to the virtual machine’s configuration
1 Make sure the virtual machine is powered off.
2 Select a virtual machine from the inventory panel.
3 On the Summary tab, under Commands, click Add Hardware.
4 Select Serial Port and click Next.
   Choose Output file to connect to a physical port on the host machine and click Next.
5 Enter the location of the output file, or browse for a location in the Output File field.
   To connect this virtual machine to the host’s output file when the virtual machine is powered on, select Connect at power on and click Next.
6 Under I/O Mode, select whether to Yield CPU on poll.
   The kernel in the target virtual machine uses the virtual serial port in polled mode, not interrupt mode.
7 Click Next.
8 Click Finish.
To add a named pipe Serial Port to the virtual machine's configuration

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select Serial Port and click Next.
5. Choose Use a named pipe to connect to a physical port on the host machine and click Next.
6. To specify a named pipe, enter the pipe name.
7. Under Near End, choose whether the application running in the guest operating system will function as a server or a client.
   - Is a server – starts this end of the connection first.
   - Is a client – starts the far end of the connection first.
8. Under Far End, specify where the application the virtual machine will connect to is located.
   - Is a virtual machine if the application that the virtual machine will connect to is located on another virtual machine on the host.
   - Is an application if the application that the virtual machine will connect to is on the host machine.
9. To connect this virtual machine to the named pipe when the virtual machine is powered on, select Connect at power on and click Next.
10. Under I/O Mode, select whether to Yield CPU on poll.
    The kernel in the target virtual machine uses the virtual serial port in polled mode, not interrupt mode.
11. Click Next.
12. Click Finish to add the physical Serial Port to your virtual machine.
Adding a Parallel Port

Parallel ports are used by a variety of devices, including printers, scanners, dongles, and disk drives.

The virtual parallel port can connect to a parallel port or to a file on the host operating system.

To add a physical parallel port to the virtual machine's configuration

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select Parallel Port and click Next.
5. In the Connection Type list, select Use a physical Parallel Port and click Next.
6. Enter the location of the device in the Location field.
   For example, the host's parallel port could be /dev/parport0.
7. To connect this virtual machine to the host's parallel port when the virtual machine is powered on, select Connect at power on and click Next.
8. Click Finish.

To add an output file Parallel Port to the virtual machine's configuration

1. Make sure the virtual machine is powered off.
2. Select a virtual machine from the inventory panel.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select Parallel Port and click Next.
5. In the Connection Type list, select Output File and click Next.
6. Enter the path and filename in the Output File field, or browse to the location of the file.
7. To connect this virtual machine to the host's parallel port when the virtual machine is powered on, select Connect at power on and click Next.
8. Click Finish.
Adding a SCSI Device

You can add any supported SCSI device that is available to your ESX Server host.

To add a SCSI device to a virtual machine’s configuration

1. Select a virtual machine from the inventory panel.
2. If you are adding a SCSI Device to an ESX Server 2.x virtual machine, make sure the virtual machine is powered off.
3. On the Summary tab, under Commands, click Add Hardware.
4. Select SCSI Device and click Next.
5. In the Physical Device drop-down menu, select the physical device to use.
6. To connect this virtual machine to this SCSI device when the virtual machine is powered on, select Connect at power on and click Next.
7. Under Virtual Device, select the virtual device node for this device to appear in the virtual machine and click Next.
8. Click Finish.

Changing Virtual Machine Options

Configuration options let you adjust characteristics of the selected virtual machine, such as the virtual machine general settings, power options, and advanced options.

Changing General Settings

Use the Options tab to adjust characteristics of the selected virtual machine. You must power off the virtual machine before you can make any changes.

To change general settings

1. On the Summary tab, in the Commands section, click Configure Options.
2. Click General.
3. To change the display name, type a new name in the Virtual Machine Name field.
4 To change the guest operating system installed on the virtual disk (for example, if you are upgrading the guest operating system), select the new guest operating system from the Guest Operating System list.

When you change the operating system type using the Version list, only the setting for the guest operating system type in the virtual machine’s configuration file is changed. The guest operating system itself is not changed. For information about installing the guest operating system, see the Basic System Administration Guide and the Guest Operating System Installation Guide.

5 Click OK.

Changing Power State Options

Power state options allow you to define actions that occur in various virtual machine power states.

To change power state options

1 On the Summary tab, in the Commands section, click Configure Options.

2 Click Power.

3 Choose the default power off option for the virtual machine.

Settings for powering off virtual machines include Power off the virtual machine and Shut down the guest operating system. By default, all virtual machines are powered off without shutting down the guest operating system. When VMware Tools is running, the virtual machine shuts down the guest operating system by default.

4 Choose the reboot option for the virtual machine.

Settings for rebooting virtual machines include Reset the virtual machine to reboot the virtual machine without shutting down the guest operating system and Restart the guest operating system to restart the guest operating system. By default, all virtual machines are rebooted without shutting down the guest operating system. When VMware Tools is running, the virtual machine restarts the guest operating system by default.

5 Choose either After resuming or Before suspending to run a VMware Tools script.
Changing Advanced Settings

To change advanced virtual machine configuration options, complete the following procedure.

**To change advanced settings**

1. On the Summary tab, in the Commands section, click Configure Options.
2. Click Advanced.
3. Select an option:
   - **Record run time information**
     - **Run with debugging information** – Runs the virtual machine with debugging information, which is useful when you are experiencing problems with this virtual machine. You can then provide this information to VMware support to troubleshoot any problems you are experiencing.
   - **Record statistics** – This option is not available for ESX Server.
   - **Enable logging** – Enables logging for the virtual machine.
   - **Disable acceleration** – Disables acceleration in the virtual machine. You might want to temporarily disable acceleration in a virtual machine if you try to install or start a program in a virtual machine and the program seems to stop responding or crash or reports that it is running under a debugger. VMware has seen this problem with a few programs. Generally, the problem occurs early in the program’s execution. In many cases, you can avoid the problem by temporarily disabling acceleration in the virtual machine.

   This setting slows virtual machine performance, so use it only for avoiding a problem with running the program. After you stop encountering problems, return to the virtual machine settings editor and deselect **Disable acceleration**. You might then be able to run the program with acceleration.
Index

A
acceleration 64
adding hardware 50
   CD/DVD drive 56
disk drive 57
floppy drive 57
hard disk 50
   network adapter 56
parallel port 61
   SCSI device 62
serial port 58
advanced options 64
alarms 30

C
CD/DVD drive
   adding 56
   configuring 39
   removing 40
   configuring
   CD/DVD drive 39
disk drive 40
floppy drive 40
general options 62
   hard disk 42
   memory allocation 39
   network adapter 46
   parallel port 48
   power state options 63
   processors 38
   SCSI controller 45
   SCSI device 45
   serial port 48
   configuring advanced options 64
   console 31

D
debugging information 64
default view 20
disk drive 40
   adding 57
   configuring 40
   removing 41

E
events 29

F
floppy drive
   adding 57
   configuring 40
   removing 41

G
general settings 62
<table>
<thead>
<tr>
<th>Letter</th>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>hard disk</td>
<td>42, 44</td>
</tr>
<tr>
<td></td>
<td>adding</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>configuring</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>removing</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>hardware configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>adding hardware</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>CD/DVD drive</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>disk drive</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>floppy drive</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>hard disk</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>memory</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>network adapter</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>parallel port</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>processors</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>SCSI controller</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>SCSI device</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>serial port</td>
<td>48</td>
</tr>
<tr>
<td>I</td>
<td>installation</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>inventory view</td>
<td>25</td>
</tr>
<tr>
<td>L</td>
<td>logging</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>logging in</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>logging out</td>
<td>20</td>
</tr>
<tr>
<td>M</td>
<td>memory configuration</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>menu</td>
<td></td>
</tr>
<tr>
<td></td>
<td>view</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>virtual machine</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Web Access</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>menu bar</td>
<td>23</td>
</tr>
<tr>
<td>N</td>
<td>network adapter</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>adding</td>
<td></td>
</tr>
<tr>
<td></td>
<td>configuring</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>removing</td>
<td>47</td>
</tr>
<tr>
<td>O</td>
<td>options</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>advanced</td>
<td></td>
</tr>
<tr>
<td></td>
<td>general</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>power state</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>virtual machine</td>
<td>62</td>
</tr>
<tr>
<td>P</td>
<td>parallel port</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>adding</td>
<td></td>
</tr>
<tr>
<td></td>
<td>configuring</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>removing</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>passwords</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>power states</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>changing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>current</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>options</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>toolbar actions</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>processors</td>
<td>38</td>
</tr>
<tr>
<td>R</td>
<td>remote console URLs</td>
<td>35</td>
</tr>
<tr>
<td>S</td>
<td>SCSI controller</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>adding</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>configuration</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>removing</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>serial port</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>adding</td>
<td></td>
</tr>
<tr>
<td></td>
<td>configuring</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>removing</td>
<td>49</td>
</tr>
</tbody>
</table>
Index

T
tasks 30
toolbar 24

V
view
alarms 30
console 31
default 20
events 29
inventory 25
tasks 30
virtual machine summary 28
view menu 23
Virtual Infrastructure plug-in 15
virtual machine
alarms 30
console 31
events 29
memory configuration 39
menu 23
options 62
summary 28
tasks 30
VMware Tools 33

W
Web Access menu 23
workspace 22
Updates for the Virtual Infrastructure Web Access Administrator’s Guide

Last Updated: June 12, 2009

This document provides updates to the Virtual Infrastructure Web Access Administrator’s Guide. Updated descriptions are organized by page number so that you can easily locate the areas of the guide that have changes. If the change spans multiple sequential pages, this document provides the starting page number only.

The following update is made to the Virtual Infrastructure Web Access Administrator’s Guide:

- Updates for the Browser Requirements Section on Page 14

Updates for the Browser Requirements Section on Page 14

In the Browser Requirements section, the information on browser support for VI Web Access needs to be updated. The latest list of VMware certified browsers compatible with VI Web Access is listed in the VMware Infrastructure Compatibility Matrixes document for ESX Server 3.5 and VirtualCenter 2.5 on the VMware Web site.